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A Raw Workflow  
in the Real World

The March of the Yellow Penguins 
(or how an efficient raw workflow was Antarctic tested)

Neko Harbour; Beach Landing; 2:15-4:45 p.m.; 64˚50’S 62˚33’W; December 5, 2005.

What happens when you have 40+ photographers cruising the Antarctic Peninsula on a 
converted Russian research (spy) ship? If you were shooting DSLR in raw (I was), you’d 
end up with major giggage—a term coined on this trip. You’d also end up putting your 
raw workflow through a severe test. I call it the Antarctic Test.

Last December, more than 40 hardy photographers boarded the good ship Akademik 
Shokalskiy, armed with a lot of digital cameras, flash cards, and not nearly enough free 
hard disk space. The photo expedition was organized by Michael Reichmann of The 
Luminous Landscape and included Michael, John Paul Caponigro, Stephen Johnson, 
Seth Resnick, and me.

Upper left, Michael Reichmann; upper right from left to right: JP Caponigro, Jeff Schewe, and Seth Resnick. 
Bottom: Stephen Johnson with his digital panoramic camera.
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When we boarded the ship in Ushuaia, Argentina, we knew we were in for a photographic 
adventure but we really weren’t prepared for the full extent of what we would see, shoot, and 
experience. At dawn of the first day, though, we got a tiny taste of what the Antarctic could be like.

Drake Passage, 6:13AM, December 2, 2005.

You are not seeing digital imaging trickery. I simply rotated the image to straighten the mast 
of the ship, which indicates just how much of a roll our ship had. I measured it in Adobe® 
Photoshop®; it was 26.8 degrees to port. And yes, we went the same to starboard. We were cross-
ing the Drake Passage, one of the more notoriously unpredictable bodies of water in terms of 
“roughage.” It can be a Drake Lake or Drake Rock & Roll. We got the Rock & Roll (although the 
crew indicated it was only mildly rough).

Cierva Cove; Zodiac cruise; 10.30-12.30 a.m.; 64˚090’S 61˚07’W; December 6, 2005.
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Once we arrived at the relatively sheltered waters of the Antarctic Peninsula, our ship became 
our photographic base of operations. We were well equipped onboard with our laptops to down-
load cards and make quick edits before going  back on deck or out on a Zodiac cruise to do more 
shooting. The Zodiac cruises enabled close approaches to icebergs and glaciers.

The Zodiacs made for rather interesting shooting platforms—great if you were in the bow and tall, not so great if you 
were in the stern and short. But the drivers were able to maneuver so everybody eventually got their shots.

      

Although the Zodiacs were fun, just being on the deck of the ship provided many photographic opportunities.  
On the left, members are shooting from deck 4, and on the right, the upper shooting level of deck 7. We went up and 
down narrow gangways and steps frequently, which wasn’t a problem in calm waters but got a bit challenging in 
rougher water.

Where does the “Yellow Penguin” name come from? Quark Expeditions, the outfitters of the 
expedition, gave us all really nice yellow parkas designed for the Arctic/Antarctic climate—at 
least the summer months. So we all dutifully wore them. The daytime temps were generally 
above freezing, so these were perfect for the climate we faced most of the time.



A	Raw	Workflow	in	the	Real	World �

One of the most challenging aspects of the cruise was to try to shoot without these big yellow 
parkas showing in every shot. When bundled we had a tendency to stagger when walking, look-
ing like big yellow penguins. And real penguins, being curious, just had to come right up to us. 
We stayed the mandatory 15 meters away from them, but there was no rule about them coming 
up to us—and they did—which made it hard to shoot them without a bunch of yellow parkas in 
the shot.

Hope Bay; Activity: Beach Landing, 1:30-2:45 p.m.; 63˚23’S 57˚01’W; December 7, 2005.

I thought it would be useful to give you background on the trip to help explain why an efficient 
raw workflow was mandatory. With some days providing over twenty hours of shootable light 
and numerous photo opportunities, we all had some major issues dealing with the massive 
amounts of files we were producing. One day shooting started at 5:30 a.m. and didn’t end until 
1:30 a.m. the next day; I shot a little over 27GB of raw images. That’s a lot of gigs…which led to 
the term giggage.
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But we didn’t just do the shooting, we also had to download cards carefully, in duplicate places, 
and with some sort of useful organization. We had to at least check to make sure what we down-
loaded was verified, which meant browsing the images and checking to make sure we got good 
copies. This was where my own personal workflow was put to a severe test.

         

I brought two 100GB FireWire hard drives along. I also brought along a bunch of DVDs in the event that the hard 
drives either failed or ran out of space. Good that I brought the DVDs, because I had to burn 10 to maintain duplicate 
copies of the raw files.

I also had to deal with multicard downloads each day, so I used a folder method to keep them relatively organized, 
although I didn’t worry too much about downloading the cards in the exact order I shot. I figured that because I set 
the camera clocks accurately to ship time when I boarded, I could use the Date/Time Captured EXIF metadata to sort 
the actual shooting time. Glad I set the camera clocks, otherwise keeping track of two cameras’ worth of shooting and 
being able to sort in order would have been a nightmare.

I was shooting with two cameras: a Canon 1Ds MII 16MP camera and its little cousin the Digital 
Rebel XT that produces a 6MP capture. Since we were traveling quite literally to the ends of the 
earth, I tried to keep the amount of gear to a minimum. I was intending to use the 1Ds as the 
primary “serious camera” and keep the Digital Rebel for snap shots. That lasted until the first 
time I filled a card and switched to the other camera to keep shooting until a break in the action 
allowed me to swap out cards. Even with 6 2GB and 2 4GB Lexar cards, I spent time running 
into my cabin or the bar to download cards to the drives. Having dual FireWire card readers 
really helped. I didn’t lose any image files (although I did lose two frames because I opened the 
camera’s card door before the camera was finished writing).

It started to become mechanical—copy the cards, point Adobe Bridge to the folders and choose 
Cache > Build Cache For Sub Folders, and then copy the resulting cached folders to the second 
drive. Then, pop the cards out, put them into the cameras and reformat. Over and over and 
over…while the ship sometimes was rocking (the waters weren’t always calm).
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While I did a certain amount of raw work onboard the ship, for printing and lecture examples,  
I really didn’t do the heavy lifting until I got home from the trip and was able to work on my 
main workstation.

After I returned from the trip, I copied all the files carefully from the various media and combined the folders and 
subfolders for a total of 103.7GB of digital captures. That was not including some obvious images that were definitely 
outtakes—I trashed them after doing a quick edit onboard the ship.

This is just one folder’s worth of raw images. 143 images (the 90 hidden files are XMP files). Imagine sitting down to 
edit over 100GB of images, which is what I needed to do to produce a story for PhotoshopNews.com within a week or 
so of returning from the expedition. I did it!
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Going through images one by one in Bridge and Adobe Camera Raw was just not going to get 
the files edited in time. I needed to resort to all my workflow tricks to get it done. My workflow 
included using saved Camera Raw settings, adjusting multiple images in Camera Raw Filmstrip 
mode, using the Copy/Paste Camera Raw settings and sometimes, opening single images several 
times to do dynamic range adjustments of images in Photoshop. I used metadata templates 
and labels, rankings, and Collections. I also used automation processing by deploying Image 
Processor as well as using batch operations with actions. I actually learned how some of my prac-
tices were less than optimal and I tweaked the steps and my workflow wherever possible.

camera Raw settings
Doing the same thing over and over—when you can use the features of Bridge, Camera Raw, and 
Photoshop—is a sure way towards long hours and often, less than stellar results. Ideally, you need 
to pick and choose from a wide and sometimes mystifying array of tools at your disposal. It’s 
often said there are many ways to do things in Photoshop, but there’s usually a best way from the 
standpoint of time and quality.

Here is an image open in Camera Raw. Rather than painstakingly opening multiple images from the same lighting 
conditions just to adjust the white balance of the shoot, I chose to save the white balance settings as a preset to apply to  
an entire folder (actually a bunch of folders) at once. While the image exposure and other settings may need image-by- 
image or series-by-series adjustments, the white balance settings tend to be constant when the lighting remains the same.

In the Camera Raw dialog box, click the arrow to the left of the Settings menu, and then choose Save Settings Subset 
from the pop-up menu (left). Choose which settings to save in a pop-up menu (center) so that you don’t have to  click a 
bunch of radio buttons. On the right, I’ve selected just the White Balance settings.
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When saving the settings, be sure to enter a useful name in the Save Raw Conversion Settings dialog box (left).  
Once saved, the settings will be available in the Image Settings pop-up menu in Camera Raw (right).

After adjusting a representative image and saving the settings or subset, you can use the settings 
in Camera Raw or apply the settings to multiple images from within Bridge. If, after saving out 
the settings you don’t see the settings inside of Bridge, you will have to restart Bridge to update 
the settings.

Once you have the settings saved, select the images you want to apply the settings to in the Bridge window.

You should see your saved settings in the Apply Camera Raw Settings pop-up menu. Choose your setting to apply it 
to all the selected images in Bridge. It may take a few moments for all the thumbnails and previews to regenerate, but 
you can continue working while Bridge regenerates them. 
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Using saved settings in Camera Raw is particularly useful when you have many images taken in 
extremely similar conditions. In the situation above, all of the shots were lit by the same lighting 
conditions, so saving a custom white balance provides an easy way of applying those settings to 
massive amounts of images. Other situations where a saved setting could be useful are under stu-
dio strobe lighting situations where the lighting does not vary, or when shooting with a particular 
lens when you want to apply a chromatic aberration or vignette corrections. Saved settings are 
also a perfect way of applying settings from the calibrate panel in Camera Raw.

Don’t try to overreach with the settings corrections. Setting exposure will most likely be on an 
image-by-image or series-by-series situation, so using saved settings would not work very well 
for exposure or other image parameters where the nature of the images changes considerably. 
For those situations, there are other ways of adjusting raw images efficiently.

camera Raw filmstrip mode
The most efficient method of adjusting images in Camera Raw is by using Filmstrip mode. By 
selecting multiple images in Bridge, you adjust the processing parameters for them more quickly.

To use Camera Raw in Filmstrip mode, select multiple images in Bridge.
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Camera Raw in Filmstrip mode

Once you have multiple images open in Camera Raw, there are several strategies you can use. 
The first approach is to adjust a single image to achieve an optimal correction for that image. As 
long as the image is representational of the others, you can then synchronize the settings of that 
image across multiple images.

When synchronizing, remember that it is the first selected (sometimes called the most selected) 
image that rules the remaining images’ settings. In the figure below, it is the image surrounded 
by a blue rectangle (the top image) that is most selected.

Shift-select contiguous images, or use the Command key (Mac OS) or Control key (Windows) keys to select  
noncontiguous images in the filmstrip.
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After selecting the images, click the synchronize button to decide which Camera Raw settings 
you want applied across the selected images. In the example above there are only six images, but 
it could conceivably be an entire folder of images. The upward limit to how many images you can 
load into Camera Raw filmstrip mode is really only limited by RAM available to Photoshop and 
Camera Raw. Performance is reasonably good even when loading hundreds of images.

The Synchronize settings dialog box allows you to select as many or as few parameters you choose to sync. It’s useful 
to choose the parameters by groups from the pop-up  menu or choose a custom subset. The options are sticky between 
applications, so if you want to bypass the Synchronize dialog box, hold down the Option key (Mac OS) or Control key 
(Windows) before clicking the Synchronize button in Camera Raw.

The results of the sync settings are updated in Bridge when you click Done in Camera Raw.

Using this method of syncing settings across multiple images can make fast work of going 
through a folder of images and adjusting multiple series or groups of images. You’ll notice that 
Crop is one of the settings you can use to sync. You need to remember that crop is both the 
actual crop size plus the rotation being applied to the images. 
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Syncing can be fast, but if you only have a small number of images in groups it’s more efficient to 
gang adjust the images. 

Camera Raw with three images selected for gang adjustments.

Selecting multiple images in the filmstrip allows you to adjust all selected images at once. For 
small numbers of images, this is quick and easy. But trying to adjust a lot of images in a gang may 
slow down the slider response in Camera Raw, particularly on slower computers.

You can apply rank and labels in Camera Raw.

An overlooked feature in Camera Raw is the ability to do ranking and labeling. The same com-
mands in  Bridge (Command in Mac OS or Control in Windows plus 1-5) add star rankings in 
Camera Raw. Pressing Command (Mac OS) or Control  (Windows) plus 6-9 adds labels. There is 
no keystroke for purple ranking, however.

This tip is useful since only in Camera Raw can you view an image at 100% or higher while still 
in raw. If you need to check small details like eyes, or check focus before ranking, doing it in 
Camera Raw provides a more accurate rank.
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copy and paste camera Raw settings
Another method of editing Camera Raw settings is by copying and pasting Camera Raw settings 
from Bridge. You can use this method across multiple images and even across images located 
in different folders, if you copy from one folder and then navigate to another folder to paste. 
However, you need to target the image whose settings will be copied.

In Bridge, a single image whose settings have been set is selected.

From the Edit menu, choose Apply Camera Raw Settings > Copy Camera Raw Settings.
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Multiple images selected in Bridge.

From the Edit menu, choose Apply Camera Raw Settings > Paste Camera Raw Settings.

The Paste Camera Raw Settings dialog box. The settings remain sticky from the last paste. If you get tired of seeing 
these dialog boxes, I suggest using keyboard shortcuts to copy and paste your settings: Command+Option+C or V 
(Mac OS) or Control+Alt+C or V (Windows).
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The selected images have been updated in Bridge to reflect the pasted settings.

You might ask why there are so many different ways to adjust the settings of Camera Raw files. 
The answer is really one of power and flexibility rules. All Adobe applications offer multiple ways 
to do similar things. While trying to learn all the ways one can accomplish what may seem like 
a simple task can be frustrating, it is this flexibility that can be harnessed to help you craft your 
own custom workflow.

Which method of applying Camera Raw settings is best? That all depends on what you are trying 
to do. I generally try to save custom settings only for those situations that occur on a regular basis.  
I use Filmstrip mode in Camera Raw often. If there are only a few images that need the same set-
tings, then I’ll select them all and adjust them in gang fashion. If there are many images separated  
in the filmstrip, it’s more efficient to sync the settings. However, if you want to tweak a single 
image and then copy and paste the settings in Bridge, the advantage is that it’s really fast. The 
end goal remains the same—to adjust raw image settings as accurately and quickly as possible.

editing metadata
It is in your long-term benefit to do as much metadata embedding as possible, but in an efficient 
manner. Where possible, apply metadata in massive groups using metadata templates in Bridge 
and Photoshop. The specifics of making templates is covered in the article About Metadata. 

After selecting multiple images in Bridge, choose Tools > Append Metadata and choose one of your saved templates 
(left). If applying a template to multiple images in Bridge, you’ll receive a prompt asking whether you really want to do 
this (right).

http://www.adobe.com/digitalimag/pdfs/about_metadata.pdf
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The results of applying metadata to an entire folder of images.

To increase the granularity of your embedded keywords, it’s useful to build keyword sets.

Metadata may seem like an unlikely candidate to radically help long-term image organization, 
but it is. While it’s been slow to grow into the mainstream, metadata is the keystone of photo-
journalism and stock photography. Metadata can actually increase the relative value of your 
images. Imagine someone searching for a very specific sort of image—an image with rich meta-
data and keywording will be more likely to be found than an image with more general keywords.

In the future, when digital photographers are literally drowning with the shear volume of digital 
images, keywords and other image metadata will be the only thing that makes order out of chaos. 
The sooner you develop a rich metadata and keyword scheme, the sooner you’ll be able to take 
advantage of the benefits. 
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Using search and collections
You may have noticed  in the screen shots of the various folders, some of the images have star 
ranking and other images have labels. By combining rank and labels, you can easily search 
through a large number of images to find specific shots, even if those images are scattered 
through a complicated folder structure such as I’ve created with the more than 100GB  of images 
I shot in Antarctica.

The Label menu showing no ratings and no labels (left), and adding a label of yellow with a star rank of one (right).

While working through images in Bridge and Camera Raw to set up image settings, I also label 
and rank the images. It takes little extra time, but can save a lot of time later when going through 
many images in separate folders.

I used yellow to mark images I wanted to consider using for my PhotoshopNews article, and 
added star ranking to images I really liked. But, considering that my raw images were organized 
in folders and subfolders, it would have been extremely difficult to go through each and every 
folder to find images I wanted to process. I solved that by using the Find function in Bridge.

The Find dialog box allows you to specify search parameters. You can choose what folder to start the search in and 
whether or not to include subfolders in the search—important considering my folder organization.

The search above was very simple—I just wanted to find all my yellow-labeled images from 
Antarctica. However, the ability to drill down in the search is very powerful, particularly if 
you’ve made use of ranking, labels, and keywords.

Your search criteria can be very specific (left). Click  the + button to add new criteria and choose the criteria from the 
pop-up menu (right).
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Each criterion has conditions associated with the search (left), and you can specify how the match function will be 
used (right).

Doing a search on over 100GB of raw images for yellow-labeled, ranked images with the keyword 
“Lamar” produced a single image. Pretty powerful!

The results of the above search; a single image out of thousands, and it took only a few seconds to find.

Going through and processing my labeled images from the Antarctica images resulted in the fol-
lowing set of images—almost 600 images had been marked with a yellow label.

The search results.
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Going from 9,833 images (that’s how many images are contained in the more than 100GB) to less 
than 600 is great. But before going any further, I wanted to save the search results as a Collection 
so I could get back to it without having to do another Find operation.

Click Save As Collection in Bridge (left) and you can name the collection and specify whether you want to save it 
based on the Find folder (right).

If you’ll need to find the same set of images again, saving as a collection—which is really just a 
saved search—will make your life easier. Your Collection will reside in the Collections section in 
the Favorites panel.

My saved collections.

To make it even easier to return to a collection, you can add the collection to the Favorites panel using the context 
menu (left). On the right, the Antarctic-Selects collection has been added to my Favorites.
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Even though I was able to edit down to about 600 images, that number was still way too large. 
For my purposes, I needed to reduce the edit even further. To accomplish that, I used the Filter 
function in Bridge.

You can filter the images shown in Bridge. I wanted to select only those images that warranted one or more stars.

The result of the filtering based on one or more star ranking.

The result of the filtering further reduced the image count to 175, which was much more reasonable 
for my purposes. At this point, the next step would be to process the images from raw to RGB. I 
could write an action, I could open a bunch of the images and save them out as TIFF files directly 
from Camera Raw, or I could use a relatively painless method of processing the files by using the 
Image Processor. For this particular task, Image Processor provided all the functionality I needed.
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Raw processing
Image Processor is very elegant in its simplicity. It was first developed as Dr. Brown’s Image 
Processor and released as a free download for Photoshop CS by Russell Preston Brown, Adobe’s 
chief art director and evangelist. For Photoshop CS2, it was renamed and included in Bridge  
and Photoshop.

In  Photoshop, choose Tools > Image Processor (left). The Image Processor dialog box (right) allows you to specify how 
to open the images, where to save them, the file types saved, whether or not to run an action after the image is opened, 
and whether or not to save the image with an ICC profile.

For my purposes, I wanted to save the raw files as TIFF files with profiles. I didn’t want to do any 
resizing at this stage. I wanted to save the files as 16-bit-per-channel, high-bit depth, native reso-
lution images for retouching. In several cases, I wanted to end up with two processed versions of 
the same image, but with different processing settings for combining later in Photoshop. I also 
intended to go back through the original raw files to see if there were any images I might like 
more. I did that and actually found some additional images.

I gang opened four to six of the processed images at once, spotted the images for sensor dust—a 
major problem that occurred in dry and windy Antarctica—and made local corrections to the 
images using the layer functionality in Photoshop. Several of the images were multiprocessed 
and were combined to help control the dynamic range of the images. Snow and ice under bright 
sunlight often proved to be a challenge.
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I ended up with about 240 images that were final candidates for my story. It was at this point that 
I needed to do a sort and reorder the images. I first sorted the images By Date Created by using 
the Sort function (View > Sort).

Determining the sort order.

Although that nicely produced a sort that was the exact order in which the shots were produced—
even though I was using two cameras—I wanted to have some editorial control over where the 
images would end up. So, from that initial sort, I fudged some of the images around. However, 
because I wanted to lock that final sort, I needed to rename the images and provide a numerical 
lock to the order.

The Bridge Batch Rename dialog box allows extensive renaming.
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The results of Batch Renaming.

At this point, the TIFF files were 16-bit, Adobe RGB files, and they were pretty much finished 
and ready to be further processed (the fact that I processed into Adobe RGB proved to be a prob-
lem later). One might think that I could just run a batch on the resulting retouched TIFF files 
and do a Save For Web process. Well, I still needed to do some fine-tuned crops for the Web, so I 
used a second Image Processor routine on the final cropped TIFF files to get the images closer to 
the final Web size.

The second Image Processor routine included a different destination folder and resized the images so they would fit the 
story format on the Web. I also included an action to convert from Adobe RGB color space to sRGB. At this point I still 
wanted to maintain an ICC profile.
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The resulting files after the second Image Processor run.

You may wonder why I wanted to do this in two steps instead of one. Good question. First, I 
would say it’s safer to step carefully when working with lots of files. I wanted to have the first 
processed files to fall back on in the event I either messed up an image—yes, it happens some-
times—and I also wanted to have the smaller files to work with for preparation for the Web.

I wanted to refine my selection edit and do some image combinations, by putting two images 
side-by-side for better layout on the Web. Rather than work with the larger 16-bit images in 
Adobe RGB, I preferred to do that work on the smaller files.

When I was done with the final image files for the Web, only then was I ready to do a final batch 
process to save the images as JPEG files.

To record the action I was going to use in the batch operation, I needed to record an actual Save For Web operation. 
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Save For Web is a bit different than recording regular saves in Photoshop, since Save For Web is 
an automated export that locks in the exact location of the saved file. But as long as you save the 
file in the recorded action to the folder you specify, you can eliminate the Save function of the 
batch operation. 

Choose Tools > Photoshop > Batch in Bridge.

The Photoshop Batch dialog box.

Many users fail to fully use actions and batching in Photoshop, which is a shame, really, since 
automating repetitive tasks is crucial to having an efficient workflow. In the batch setup shown in 
the figure above, all I needed to do was choose the correct action that I named SFW-JPG, select 
Suppress The File Options Dialog (something I almost always select), and suppress the Color 
Profile Warnings. Since the recorded action contained the save destination, I set Destination to 
None. One point to note, however, is that the action I recorded not only contained the Save For 
Web step, but also a Close Without Saving step. Without the Close Without Saving step, you 
would end up with hundreds of files open in Photoshop.
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The results of the batch operation. Note that some of the images have been combined two-up for layout purposes.

The final layout as it appears on PhotoshopNews.com.
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The story and images were posted to PhotoshopNews within a couple of weeks of our return 
from Antarctica. The image processing was the easy part —the hard part was the writing and 
final posting. You can see the results for yourself by going to PhotoshopNews.com and clicking 
the Antarctic Expedition link in the Contents column.

While that story was done, this one wasn’t. I wanted to do a DNG archive of the images from the 
story and I needed to make prints for a print discussion, so I still had work to do on my files.

Using the DnG converter
There’s been much discussion in the last couple of years regarding the risks associated with 
long-term preservation and conservation of proprietary raw file formats. I’m a strong believer 
that in the long view, the current proliferation of proprietary and undocumented raw file formats 
presents the photographic industry and all digital photographers with a major dilemma and sub-
stantial risk for preservation. Short term, I understand the difficulties faced by the digital camera 
companies and I sympathize with them, but only up to a point.

A project funded by the U.S. Congress named the National Digital Information Infrastructure 
and Preservation Program (NDIIPP) has identified seven sustainability factors that impact the 
long-term preservation and conservation of digital objects (that is, files). They are: Disclosure, 
Adoption, Transparency, Self-documentation, External dependencies, Impact of patents, and 
Technical protection mechanisms. Proprietary raw files and their undocumented nature run 
seriously afoul of pretty much all of these factors.

As a result, I’ve adopted a process whereby I convert my proprietary raw files to DNG format 
using the free DNG Converter available on the Adobe website. For more information about 
DNG, see www.adobe.com/products/dng.

Going back to an edited version of my final Antarctic-Selects collection, I used Bridge to drag the raw files to a new folder.

Dragging the images from Bridge into a folder while holding the Option key (Mac OS) or Alt key (Windows) copies the 
files into the destination folder rather than moves them.

http://www.adobe.com/products/dng
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The DNG Converter main dialog box ( left ), and the preferences I chose (right).

I chose to save a medium JPEG preview, used the lossless compression, and preserved the raw 
file, meaning I didn’t convert to linear. I chose not to embed the original proprietary raw file 
inside of the DNG file. Since I was also backing up the original raw files and I wasn’t engaged in 
scientific or forensics photography, I didn’t feel the need to embed the original raws.

From the processed DNG files, I further edited the selection down to 28 final images that would be processed into 
print-ready images.

To get the final print-ready images, I went back to the original DNG raw files for reprocessing.  
It seems I kind messed up when I had previously processed the first round of TIFF images—I had 
set the Camera Raw workflow settings to Adobe RGB.

This was the workflow setting used on the initial TIFF process. I had to change them from Adobe RGB to ProPhoto 
RGB for the print processing.
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Since I was going to be making these prints on my Epson 4800 printer, I wanted to use the larger 
ProPhoto RGB working space as the starting point for the print images. Yes, I’ll admit I made a 
mistake and later decided to change the working space of the images. But with automation, it wasn’t 
such a hassle to go back to the original DNG files for reprocessing. It was only time that was lost.

The Batch process dialog box for the second batch processing routine to produce print images. I set the Camera Raw 
color space to ProPhoto RGB.

The batch operation called the action that I had created for producing the print-ready images.

I had recorded an action named Print RGB 11x16 Size, so the processed images were the correct 
size and sharpened for final output. Rather than resample the images, I used the Image Size step 
to set the image dimensions and let the resolution fall to 300ppi without resampling. Wherever 
possible, I prefer to use the raw file’s native resolution rather than up sampling or down sampling 
the images. 

I used PhotoKit Sharpener from PixelGenius to do the capture sharpening as well as the final 
output sharpening. (For the purposes of disclosure, I must tell you that I am a principal of 
PixelGenius and worked with Bruce Fraser and the other members of PixelGenius to develop 
the PhotoKit series of products. That doesn’t alter the fact that I personally use the products we 
develop, but I thought it would be useful to let you know my involvement.) I flattened the images 
after the capture sharpening but preserved the layers for the output sharpening. 
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The final processed images ready to print.

After running the batch process, I had to go back into the images for a certain degree of retouch-
ing—primarily spotting those sensor dust spots again. A few of the images required special 2x 
processing and recombining in Photoshop to allow for enhanced dynamic range adjustments. 
All told, the reprocessed images for printing took a couple hours of additional work. I used 
Photoshop soft proofing to fine-tune the color and tonality of the images prior to printing. The 
images were printed for an actual image size of 11”x16” on a paper size of 17”x22” to allow for 
extra white margins.

The prints were used for a special taped segment of Michael Reichmann’s The Luminous Landscape 
Video Journal. In the segment, Michael and I compare our prints and talk about the Antarctic 
experiences we shared. 

One of the final print images shown here is a Photoshop zoom of 25% to give an indication of how the image sharpen-
ing and tone and color looked in the final print.

http://www.luminous-landscape.com/video_journal
http://www.luminous-landscape.com/video_journal
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What I learned
Developing a flexible and efficient workflow is critical to managing the volume of digital 
images today’s photographers are forced to deal with. There are steps you can take to maxi-
mize efficiency and if you learn the ins and outs of the various component applications in your 
workflow—Adobe Bridge, Camera Raw, and Photoshop—you can easily adapt your workflow 
for the specific tasks at hand. Even an experienced user like me sometimes makes mistakes, and 
developing a robust backup plan can help you recover from some of the errors that are bound to 
creep into your workflow.

I also learned that photographing in Antarctica is an unbelievable experience. I feel incred-
ibly fortunate to have been given the opportunity to go on the expedition. I’m already looking 
forward to next year’s expedition—a 20-day cruise, which will afford even more photographic 
opportunities. Next time I’m taking a lot more hard drives…

Additional resources
Expedition Outfitter: Quark Expeditions:  www.quarkexpeditions.com

Expedition Organizer: Michael Reichmann of The Luminous Landscape: www.luminous-land-
scape.com (Sorry, the February 2007 Expedition is sold out.)

Adobe DNG Format and the free DNG Converter:  www.adobe.com/products/dng

PhotoshopNews.com articles:

DNG Workflow Part I 
http://photoshopnews.com/2005/05/23/dng-workflow-part-i/

DNG Workflow Part II 
http://photoshopnews.com/2005/05/25/dng-workflow-part-ii/

Digital Preservation 
http://photoshopnews.com/2005/05/11/digital-preservation/

Antarctica Expedition 
http://photoshopnews.com/feature-stories/antarctica-expedition/

Additional Adobe Pro Solutions White Papers and Primers: 
www.adobe.com/digitalimag/ps_pro_primers.html

About Metadata by Jeff Schewe

A Color Managed Raw Workflow from Camera to Final Print by Jeff Schewe and Bruce Fraser

Highlight Recovery in Camera Raw by Jeff Schewe

Personal equipment list for the expedition
Canon EOS 1Ds MII Camera 
17-40mm zoom 
24-70mm zoom 
70-300 DO/IS zoom

Canon Digital Rebel XT 
10-22mm zoom 
28-135mm IS zoom

LowePro DryZone 200 camera bag 
LowePro Slingbag 200 AW (the one I actually used the most!)

2 4GB Lexar cards 
6 2GB Lexar cards 
2 Lexar FireWire card readers

17” Apple G4 Laptop 
2 100GB FireLite firewire hard drives 
10 DVD’s burned for backup 
Epson P2000 for emergency in-field downloads (used a couple of times)

http://www.adobe.com/digitalimag/ps_pro_primers.html
http://www.adobe.com/digitalimag/pdfs/about_metadata.pdf
http://www.adobe.com/digitalimag/pdfs/phscs2ip_colormgraw.pdf
http://www.adobe.com/digitalimag/pdfs/phscs2ip_hilight.pdf
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For	a	comprehensive	overview	of	Photoshop	CS2,	
please	visit	www.adobe.com/products/photoshop.	

Adobe Systems Incorporated
345	Park	Avenue,	San	Jose,	CA	95110-2704	USA	
www.adobe.com
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Adobe Photoshop CS2 
Adobe Bridge version 1.03 
Camera Raw version 3.3 beta

Epson America, Inc. made a variety of printers available for the expedition, an Epson 
Stylus Photo R1800, an Epson Stylus Photo R2400 and a pair of Epson PictureMate 
Deluxe Viewer Edition 4x6 printers. I have to tell you, while the R1800 and R2400 
printers got a workout, the PictureMates were the hit of the trip. People were making 
snapshots to trade with other people and a lot of prints were made for the Russian crew 
and the Expedition Team. We finished off all the ink and media that Epson provided, 
which was a lot!

Map of voyage 
Total distance traveled: 1874 nautical miles 
Most southerly point:12:30 a.m., 65˚07’S 64˚02’W, December 6, 2005

www.adobe.com/products/photoshop/main.html
www.adobe.com
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